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INTRODUCTION



For quick prototyping of PC boards and microwave circuits it is often preferable to use circuit board milling machines. One problem is tying together the circuit and mask design programs, in our case Microwave Circuit Design (MDS) from Hewlett-Packard, with the milling machine. Of course, there are “standard” files, e.g. Gerber, that one can use to export the design to other programs, but surprisingly often there are many problems involved in such transfer. Moreover, the details will be very dependent on the exact setup and equipment. Therefore, it is difficult to give some “general” procedure for transferring board layouts from MDS to milling machines, but we hope that our example and experience will serve others in troubleshooting their setup.

So, here’s what we do at Electrical Engineering Department of Portland State University to produce microstrip circuit boards for RF/microwave circuits.

We have a circuit board milling machine made by a German company named LPKF that you can “describe” your design to and, hopefully, it will produce your board for you from a blank sheet of copper. The problem is that the language it understands is not the same as what we use in CAD design tools here at PSU; so you have to produce a translation. This tutorial describes how to do this translation, starting from a simple design created in Hewlett-Packard’s MDS program.  A layout is created from the design and transferred to a PC where the programs that allow us to mill a microstrip board reside.  A program called CCam will be used to convert the layout into a series of files describing the microstrip circuit on many levels, while preserving the physical dimensions.  This program will also define the board surrounding the microstrip circuit so it can be cut out also.  These files will then be transferred to the program that actually controls the milling machine to be translated into detailed commands the milling machine will follow.  As an overview of the sort of processing steps required when using a circuit board milling machine, it should be of interest also to anyone who has never produced a circuit board from a computer generated design schematic.

MDS



The sample design we used in this tutorial consists of the matching network for the amplifier in Figure 2.5.7, page 79, of the textbook “Microwave Transistor Amplifiers - Analysis  and Design,” by G. Gonzalez.  The design frequency that was chosen is 1 GHz. You can pick any layout, just make sure it is simple to begin with!

Generating an HPGL layout file



The first step is to take your MDS layout (a hardcopy of which you should already know how to generate) and instead of outputting it to a printer, output it to a plot file.   Go to the PERFORM/PLOT window and make the following  changes to the settings.  

a)	Select ‘Plotter Options.’  In the pop-up window, type ‘cat > /dev/null’ and then click on [continue].  

b)	Back in the main plot window enter the name you want to give your saved plot file in the ‘File name:’ box (keep the name to no more than eight lower case characters so you don’t have to rename it when you move it to the DOS-based computer.  MDS will automatically add a number extension to your file’s name if you’ve chosen a name that already exists so don’t worry about accidentally choosing a name you’ve already 

	used.

c)	The output device to select (from all the choices lined up along the left side of the window) is the hp7475a.  

d)	Enter ‘1’ in the ‘Scale:’ box and notice that when you hit <RETURN>, the square 	enable box next to ‘Fit’ (on the same line) gets de-selected.  

e)	Under ‘Plotter size (ANSI):’, select ‘Fit’ and under ‘Rotate’ select ‘0’.  Now, click 	on ‘Plot’ to send your layout to the plot file.

The layout file you just created is in a format called HPGL (short for Hewlett Packard Graphics Language).  It was originated by HP as a means of communicating graphics output between their workstations and pen plotters and has become an industry standard.  The data in it is in ASCII text, and consists of one long string - one plotter command after another - that tells the plotter what actions to take with its tools: the pens. The most important change we made in the plot settings before we output the data to a file, was to assign a scale setting of one.  This told MDS to scale our plot to its actual (very small) circuit board size instead of enlarging it to “fit” an entire sheet of paper, as we typically do when we print a hardcopy.

Transferring HPGL layout file to PC



Since everything you do from now on will be on a DOS based PC operating under Windows, make a copy of your plot file to a 5 ¼” high-density (1.2 Megabyte) floppy disk.  The procedure will depend on your network capabilities, but if you have a PC with a 5 ¼” drive on the network, the following procedure will suffice. At PSU, you could do this on one of the networked PC’s in PCAT 139.  To download your file from the network, do the following, 

a)	At the DOS prompt, enter ‘ftp flotsam’ (where “flotsam” is the workstation with your layout file(s)).  The ftp program will then prompt you for your username and password.  

b)	At the ftp prompt, type ‘more’ followed by <RETURN>.  

c)	Use ‘ls’ and ‘cd’ to change to your (remote) account directory where you saved your file.  

d)	With your 5 ¼” floppy in the b: drive, do a ‘lcd b:’.  

e)	Transfer the file with ‘get <your file’s name>’.  The screen will report when the transfer is complete.  

f)	To be sure the file was received, enter ‘ll’ for a local listing of the contents of the floppy.  Then type ‘quit’ to exit ftp. 

Circuit Cam (CCam)



CCam is a program that provides editing windows where you reinterpret your original HPGL file to CCam so that it can produce several new files from it.  These files contain your layout data in the form required by Boardmaster, the program that actually will run the mill/drill machine.  CCam produces files of three basic functional types:  a) A script (.scr) file containing a record of all the input entries you make in the various editing windows;  b) one or more production files, each holding production data that will tell Boardmaster how to do the tasks defined for a particular layer (coincidentally, these are also HPGL formatted files); and c) a graphics file in EDIF format that contains the image you work with in the graphics window of CCam. Of the input formats accepted by CCam, HPGL is one of the easiest to handle (meaning it requires relatively little          modification) perhaps because it is the same format in which the production output files are written.

Carry your 5 ¼” floppy with the HPGL layout file to  the PC that is used to run the two programs that pre-process the plot file (CCam) and operate the milling machine (Boardmaster).  Boot up the machine and put your floppy in the a: drive.  Using the Windows File Manager, make a new sub-directory on the c: drive to hold all the work you do.  Then copy your file into your new directory.  It is very important to take your time here and be sure your directory is properly defined and that you remember its name.  To avoid accidentally overwriting someone else’s work, ALWAYS double check before saving your work that your directory is the named destination, as CCam tends to change directories unexpectedly.

Our simple board design has two layers of interest:  One comprising the copper microstrip line, and a second virtual layer defined for the sake of convenience to separate the operation of cutting the board out of sheet stock from the operation of removing copper.  It helps if you keep this notion of breaking the job up into separate tasks (corresponding to layers) in mind because the way tasks are organized contributes significantly to the ease or difficulty you will encounter during the actual milling.  Recall that to an HPGL file a tool means “pen”.  But in CCAM a tool is not only a pen, but also any of the numerous special bits used by the milling machine.  The tricky question arises almost immediately of what tools you want to define (i.e. their shapes, sizes, and names), and what you want to do with them (their ‘tasks’ and sequence of use).  CCam is where you make these decisions.

DATA FORMAT



When you first bring up CCam, go to the VIEW menu and set DisplayUnit to [mm].  Then go to the FILE menu and select DATA FORMAT (see Figure 1).  In the ‘Data Format + Aperture/Tool List’ window, you will begin describing how you want your HPGL layout file  interpreted.  Within the Data Format area (top part of window), select HPGL in the ‘Type:’ combo box; then select Microwave in the ‘Name:’ combo box to identify this particular setup as the format list, and settings to use with the input data for this tutorial.  When you do your own boards, you will probably want to assign a different name to format lists and settings you develop, but you can use Microwave as a starting point. Next, click on ‘More...’  to pop up the HPGL dialog box, which is used to enter the resolution of the HP plotter (actually the resolution of the LPKF milling machine). Enter the number, 0.001 inch (.0254mm), and click OK.  Now go down to the Apertures/Tools area of the ‘Data Format + Aperture/Tool List’ window, and at the ‘Unit:’ combo box, select 0.001 inch again. Notice also that under the ‘Unit:’ combo box is another larger box with the heading, No.(D or PA or similar), over the top left corner.  This is where you define the shapes and sizes of all the “pens” (bits, actually) you will be inserting in the cutting head of the milling machine (remember, a pen in the language of HPGL corresponds to a tool; for us it is a milling bit of some sort) to carry out the job of milling the board.  Every “pen” has:  a number, size ,mode (its motion when it cuts), and type (its basic shape; round, square, etc.).
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�. Data Format Window







Pens(Tools) and Definitions



For our simple board layout you need three pens numbered 1, 2, and 3. Examine the other entries in this pen list but don’t change anything since it’s already set up for this tutorial.  Normally, to define new pens (i.e. tools), it is easiest to work from an existing list and simply modify the existing definitions. For example, if the present list was to be the starting point, you would:                                                                                                          

a) 	Highlight a pen in the list by clicking on it with the left mouse button.                         b)  Using the pull-down menus underlying the small boxes to the right, you would (for 	most microstrips) select Draw for ‘Mode:’ and Round for ‘Type:’.                                              c)  You would also change the number of the pen (at the ‘No(D)’ box) and specify the 	size parameters for it.                                                                                                             d)  Once you’re  satisfied with the changes you entered for the still highlighted pen,  the 	last step is to click on ‘Accept’. 

This process is then repeated for a each pen, clicking ‘Accept’ as you finish pen definition.  Notice that there is a ‘Remove All’ button to remove all pen definitions from the list and a ‘Remove’ button that removes just the highlighted pen. When you are done with pen definitions go to the upper right corner of the window and click ‘OK’.
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 DATA INPUT



The next step in the processing chain is to convert your original layout file to the EDIF graphics format of CCam.  EDIF stands for Electronic Design Interchange Format, another industry standard.  Begin by selecting DATA INPUT from the FILE menu and refer to Figure 2 as you read the following instructions.  Since this is your first time through the program, click on ‘New...’ with the left mouse button.  Now, ignoring any existing entry, enter a new name in the Identifier dialog box for the ‘Job:’ (no more than eight characters and no extensions).  ‘Job:’ here refers to the title of the list of files you wish to input. We have just one input file - our single HPGL file (output from MDS) - so having a title for our list is overkill.  Nonetheless, the program requires it because the name you enter will be used as the prefix for naming the EDIF file CCam will soon create.  (Later, you can just ‘Rename...’ existing jobs to streamline data entry). Next, set the ‘EDIF Unit’ to the same value (0.001 inch or 0.0254mm) you assigned to the resolution and the Apertures/Tools unit in the DATA FORMAT window and be sure there’s an X in the ‘Flash to Macro’ box.

Move down to the lower half of the window and click on ‘-All’ to clear out the file names left over from the last job.  Next, click on  ‘Select...’ and use the ‘Directories’ box of the ‘Select Production File’ dialog window to traverse directories to your MDS layout file. Select your file by highlighting it in the ‘Files’ box, then clicking OK.  Back in the main dialog window, notice that the ‘Format Type:’ is updated to HPGL automatically.  Be sure the name of your MDS layout file is highlighted in the large box, and then, moving down the list to the right of the box, select for ‘Format Ref:’ the name, Microwave.  Recall this is the name we gave our Data Format & Aperture/Tool List for this tutorial.  In the ‘Layer Name:’ box, select WiringComp and for ‘Orientation:’ select R0.  The ‘Color:’ can be any color you want.  Leave ‘Origin x:’ and ‘y:’ set to zero.  Double check that all entries are correct, then click on ‘Accept’ followed by ‘Run’ (upper half of window).  Your layout should appear soon in a new window called the graphics document window, with the heading ‘Circuit CAM - [Grafik=<full_path_to_your_EDIF_file>.edi.]’.  If problems were encountered in the conversion of your MDS file, they will be listed in a separate window called the Log + Error window (reached using [CTRL]-TAB).  As long as your layout appears basically correct, don’t be too concerned about pen errors at this stage.  If you get a device input error, try repeating your data input using a different job name.  Return to the layout screen by toggling [CTRL]-TAB. 



WORKING WITH  YOUR LAYOUT

 

Checking your Layout



The graphics document window is where you check your layout for accuracy in case the conversion process misinterpreted your data or you entered incorrect units.  Use the VIEW menu in combination with the cursor and the coordinates listed in the lower left corner to measure some known dimensions of your layout on the screen.  The visible grid and cursor grid can be set from the VIEW menu by selecting ‘Grid + Unit’.  If the layout is off by more than 0.2mm from the correct design size, you will need to back up and re-check some of your previous entries made in the Data Format window. (For microwave boards, the dimensions should be very precise.  0.2mm was chosen somewhat arbitrarily but the maximum tolerable error ought to be established empirically).  Refer to pages 29-31 of the CCam reference manual for more information about checking your layout for accuracy.  If the dimensions look good, go to the File-SaveAs dialog window, and in the ‘Source:’ box select ‘Document’.  Then save everything you’ve done up to this point.  Make file names eight characters or less in length and be sure to include a .edi extension.  The file is saved as an EDIF-formatted graphical record of your layout.  However, this is not the form in which Boardmaster works with your design.  To translate the data further, some additional refinements and definitions need to be made.

Refining the Layout



First, any extraneous text or other MDS artifacts on the CCam layout need to be erased so they don’t get milled into the board.  Text can be selected by clicking on it or by holding down the left mouse button to draw a box that selects anything it entirely surrounds.  It can be deleted by hitting the [Delete] key.  To see corrections at any time, refresh the display by selecting View->Refresh.  Second, the microstrip shading style needs to be 

changed from diagonal lines to solid color by selecting the whole layout (using box select), then going to Edit->Group->Close Path to Polygon.  At this stage, it’s a good idea to refresh the drawing on the screen by clicking with the third mouse button anywhere outside the microstrip, then clicking ‘Cancel’ from the pop-up choices offered.  Next, select ‘Refresh’ from the VIEW menu followed by ‘Overview’.  Look over the refreshed display to be sure nothing was left selected.



Cutout Creation



The edge of the board must be laid out since MDS provides just the microstrip line (as mentioned above, we decided to define a separate layer for this edge, which will be the outline for cutting out the board).  

�
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�.  Layer Window





Open the Layer dialog window by selecting Edit-Layer...  In the top left box within this window (see Figure 3), there is a short list of layers and sub-layers with names like WiringComp1.  Click ‘New..’ and in the Identifier box that pops up, highlight ‘Board’ and click OK.                                                                                                             

Now, click inside the small box next to ‘Layer’ (just above the Accept button).           

Pick a different color from the color list (inside the Display box) so the board layer you are about to create will not be the same color as the microstrip.                                 

Go to the Geometry box, enter 2.00mm for ‘Pathwidth:’ and also select ROUND for both ‘CornerType:’ and ‘EndType:’.  (The pathwidth must be the same as the size of bit used to cut out the board.  Bit sizes are listed on the outside of their plastic storage cases.  A fairly standard bit for cutting out boards is the 3contour20L which you should specify here).  Hit ‘Accept’.  This should cause ‘Board’ to change to ‘Board(layer)’ and the specifications listed for it to be updated with the new pathwidth and color you chose.

Make sure that ‘Board(layer)’ is highlighted.  Go all the way down to the lower left corner of the dialog window and click OK.                                                                                 

When the display of your layout returns, select New->Path.  You shall see a little blot appear at the center of the cursor crosshair.  This is the “paintbrush” for drawing the	 board outline.                                                                                                                                   

Using the mouse and clicking the left mouse button for corners, draw the outline of your board layer around the microstrip line.  For this design, this line will be approximately as wide as the microstrip itself.  Jot down the coordinates of the each corner as a reference to help you make the board rectangular as you draw it.  Neatness counts so make your lines as straight as you can.  If you make a mistake you can erase lines by hitting ESC twice.  (If you need to unselect something you selected, use               Edit->Cancel).  When the outline is complete, hit ESC twice to get out of Draw mode.                   								                    

An origin for the x-y coordinate system (or “zero point” as CCam calls it) must be defined.  Place the cursor somewhere in the lower left portion of the screen.  A good spot is the corner of the board outline you just drew around the microstrip.  When the cursor is where you want it, click the left mouse button to place a tiny highlighted box on the spot; then go to the Edit menu and select Make Zero Point.  Confirm (by moving the cursor) that the lower left corner of the board has x,y coordinates of 0,0.  Now, whenever the board outline is selected, an X should show up on the zero point (you may need to zoom in to see it).  



Summary of Working with Layout



To recap what you’ve done so far, a layout of a schematic produced in MDS has been transferred from one platform to another (SUN WS to PC), from one operating system to another (UNIX to DOS) and translated from one program format to another (MDS to CCam), while preserving the mechanical (dimensional) characteristics of the layout.  In addition, you removed some unwanted leftovers from MDS (that are fine for hardcopies but would trash a circuit board) and the outline of the board was added.  And, as there are plenty of opportunities for errors in this process, the graphics document window was used to double and triple check everything.  Now that the drawing is perfect, the only remaining steps are to define how you want the milling machine to remove copper from the board so as to leave only the microstrip (in CCam parlance this is known as “insulating” the board), do a couple more housekeeping things related to layer specifications, and then output it all   in a format tailored for the milling machine.



INSULATING THE BOARD



For the operation of removing copper from the board (i.e. insulating the board), return to the File menu and select ‘Insulate...’.  The dialog window that appears (Figure 4 next page) is where you define how you want the milling machine to tackle the job of removing copper.  Some of the factors to consider are, for instance, how precisely square the inside corners of the microstrip must be, how big an area of copper needs to be removed and the sizes and types of cutting bits that are available. You can begin to see the association between the size and shape of bits and the precision obtainable from them.  Smaller bits do more precise cuts but take longer, and wear faster than the less precise larger bits. The bits are expensive so chances are you will not have every conceivable size and shape from which to choose.  Hence, compromises are required as you make your choices.

Procedure

In this window, CCam gives you the capability of splitting the job into multiple user-defined tasks corresponding to a layer and tool you wish to use.  As a starting point, a safe working assumption is that a task corresponds to the work of a single tool(bit).  The choices you enter in this window for insulating your board constitute an insulation job.  Complex boards sometimes require several different jobs to complete whereas our simple board can be handled by just one job.  The procedure is as follows:
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Enter a unique name for your new job by clicking on ‘New...’ and typing in the name,  or use Microfinal, the one created for this tutorial (Later on, you can recall a previously defined job by selecting it from the list in the Job list box).   			 

If you are starting fresh, go to the box labeled ‘Source Layer’ and for ‘Wiring:’ bring in the name, WiringComp(layer).  For future reference, remember this as the layer that you always use for your “wiring.”  						         

Go to the next line and for ‘Board:’ bring in the name, Board(layer).  Recall that we already defined these layers (see above).  We don’t require the last two lines so they should show ‘-Off-‘.  									         

Move to the left to the ‘Task(Layer)’ box and click on Add;  Then highlight ‘WiringComp’ if not already selected.  						         

Directly underneath is the ‘Tools’ box where destination layers are specified.  For destination layer one, enter ‘Milled_CopperP’ and be sure the diameter is listed as   .01 inch (or the millimeter equivalent, .254mm) and the overlap is .0508mm.  Remember that the units can be specified globally by selecting DisplayUnits from the View menu.  Inches sometimes make it easier to compare tool bit sizes written on the outside of their storage cases with entries in windows whereas millimeters simplify your work in the graphics window where MDS’s use of millimeters is retained.  		         

For destination layer two, enter ‘Milled_CopperS’ and be sure it has a diameter of 2mm and the same overlap (.0508mm).  The P and S in the names stand for primary and  secondary, which are important designators for CCam.  The diameter here corresponds to the actual tool diameter, so it’s a good idea to double check that you have a bit of the specified size.  							         

Moving down to the bottom area of the dialog window, activate ‘Inner Insulation’ and for ‘Insulation Grid’ be sure .001 inch (0.254mm) is listed.  This is ten times smaller than the dimension above for simplicity.  The important thing is that it’s smaller.        

In the Direction box, turn ‘Serpentine:’ off and activate the ‘Clockwise’ button.  The reasons for these particular selections is well-documented in the CCAM manual.  



Now, click on ‘Accept’; then on ‘Run’ and watch the screen for progress reports as the program determines the paths that the milling head of the tool will take to insulate your board.  This process entails a tremendous number of calculations and so may take a while.  When CCam finishes, you will be returned to the graphics document window where you should see the microstrip surrounded by a sea of lines that represent the milling paths CCam calculated to methodically remove copper from the board based on the specified widths of the bits and overlap. An example is given in Figure 5. 

If an error occurs in the above process and CCam detects it, it will deliver an error message to the screen and refer you to the Log & Error document window.  [CTRL]-Tab brings this window to the foreground for viewing (more about this window is on manual pgs. 166-7).  If the insulation tracks, the board outline, and the microstrip all appear to be correct in the graphics document window, then go to the File menu, and hit Save (or SaveAs) to preserve a copy of this window in EDIF format.





�
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�.  Sample graphics output window. 

GENERATING PRODUCTION DATA FOR THE MILLING MACHINE



Everything you do in CCam to adapt your raw layout to LPKF’s process for manufacturing a board is in EDIF format, which is well suited to recording both the graphical display and netlist information required to edit the design layout.  However, all the milling machine requires is a sequential set of instructions telling it where to go next 

with the milling head, and whether to mill or drill as it goes.  This is similar to the way a pen plotter works so the last thing you need to do before exiting CCam is to translate your EDIF data to HPGL format.  This is done in the DataOutput window.

Data Output



From the File menu, select ‘Data Output’.  In the dialog box that comes up (Figure 6), select ‘New...’, then give this job a new name in the ‘Job:’ combo box. (Be careful you don’t confuse this job with your insulation job - the two are NOT the same and require different names).  Next, select the ‘Fixed’ radio button and type in  the full path of the directory where you’d like CCam to place the output files it creates.  A good choice is the working directory that you previously defined.  The program does not allow you to transverse directories if you need to refresh your memory of where your files are located.  If you are in doubt where to send the output files cancel the Data Output window and go to the Windows File Manager to find an appropriate directory in which to store your output files.
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�.  Data Output Window.

Task List



In the lower left area of the window is a mostly empty box labeled ‘Task List’ where the output files to be created are listed as you define them, which you do in the ‘Task’ box that occupies the entire right side of the window.  Recall how you broke the milling job into separate tasks, which were the board(layer) and wiringcomp(layer). A similar division of labor is required when you need to separate the work of each milling bit into its own output file.  When you start the milling machine up in Boardmaster, each of these files will be sent to the milling machine describing what it is supposed to do.  The first of the three output files you’ll define will hold the instructions for work to be done to the previously defined Board(layer).  

First hit ‘-All’ to clear old tasks from the Task List.  

Select Board(layer) in the ‘Layer:’ combo box.  

Go to the ‘File:’ box and enter a unique descriptive name (8 characters max.) plus the extension, .brd.  This extension isn’t required but serves as a useful mnemonic.   

Make sure ‘Format Type:’ is HPGL as before.  ‘Format Ref:’ should be ‘Microwave’ as defined earlier  (see section II.B above).  

Also confirm that the check boxes for Orientation, Origin, and Scale are not set.  The combo box for orientation should have the entry, RO.  ‘x:’ and ‘y:’ should both show 0mm, and there should be a 1 in the Scale box.  

Hit ‘Add’.  This will place the task in the ‘Task List’ box, accompanied by the word, Create. 

Go back up to ‘Layer:’ and select ‘MilledCopperP’ and in the ‘File:’ box, type in a new name, this time with a .mcp extension to remind you of milled copper-primary.  Leave the other settings the same.  Hit ‘Add’.  



Repeat this operation for the ‘MilledCopperS’ layer, assigning it a unique file name with the extension, .mcs (milled copper-secondary), concluding by clicking ‘Add’ a third time.  



Now, click ‘Accept’ followed by ‘Run’.  



This completes the process of outputting the files in a format compatible with Boardmaster.  Three files should appear in the directory you specified, and will be the only files you will use in Boardmaster. Exit CCam and be sure to use ‘Save Script’ on the way out to update the script for the session.  This will ensure that you can reload the final version of your graphics window in a future session to make changes or corrections. 



Boardmaster



The final preparations for milling are done with the BoardMaster utility.  BoardMaster is a Windows program that acts as the automatic control for the LPKF plotter.  HPGL formatted files from CCam are read into Boardmaster and then can be viewed on the screen exactly as they will be milled and cut by the LPKF machine.  It is in this program that you will actually select the tools to do the milling and cutting.  Once everything is lined up and the command to start is given, BoardMaster automatically sends the appropriate commands to the LPKF machine via serial cable.  This means that your primary concerns now should be whether the correct information is brought into Boardmaster, the desired tools are chosen, and whether the board to be cut is correctly placed in the machine.  The entire process can be thought of as four steps.



Data Input - This is where the CCam output files are brought into Boardmaster.  This is also where the tools are assigned for cutting and milling.

Placement - Once Boardmaster receives the data, the design must be placed somewhere on the on screen board.

LPKF Machine - At this point you are finally able to work with tangible part of your project.  Careful setup is necessary to insure correct operation when you go to actually mill and drill.

Milling/Drilling - The process is fairly simple once you get to this point but there are a few details that deserve careful attention and will be mentioned.  







DATA INPUT 



You must begin by starting a new job.  To do this click on ‘Job’ on the tool bar.  Select ‘New’ from the list.  This starts a new job that will be called default until you click on ‘Save As’ and give it a name.

Now it is time to import your files from CCam.  These will all be entered as a project.  Select ‘Project’ from the bar on top.  Click on the ‘New’ button and enter a name for your circuit in the field.  This can be anything.  It is, however, important that you remember what you enter here.  Check the unit box to see what units are currently being used.  It should say inch or mm.  NOTE: The value you enter here is how Boardmaster will scale the incoming files.  This means that it must match the output scaling from CCam.  It is suggested that you enter 0.001 inch or .0254 mm.  Enter the appropriate value for the units being used.  You can change to the other system later if you want and Boardmaster will adjust all values automatically.

Once the scaling has been correctly entered, Click on the ‘Add’ button and go to your directory containing your CCam files.  Select any of your CCam output files and click on ‘Yes’ to change the directory if asked to.  Repeat this procedure to select all of your output files and add them to the list.

All of your files should be in a list in the Phase File box.  A phase corresponds to a particular part of your total job, i.e. board cutout, milling primary insulation.  The output files of CCam each correspond to a phase.  Now you must assign a phase to each file.  This is where it is important to remember what each file contained.  Click on the top file and select the corresponding phase and tool used to perform the phase.  Keep in mind these are the tools the machine will use to trace the lines you defined with pens in CCam.  The diameter of the tools should match the appropriate line thickness as specified in CCam, otherwise you will have a problem of too little or too much being milled.  For example, don’t select a .1 inch diameter tool to mill a line defined by a 100 mil pen.  If you are still not sure what all of this means, see the paragraph below.  If multiple pens are defined you must define a corresponding tool for each pen.  Repeat the process until every file input from CCam has a phase and tool assigned to it. 

In addition to milling instructions, your file also contains information about the cutout of the board.  You can select CuttingCompSide from the phase list and select a cutting tool like 3Contour20L.  If you are bringing in the file that has the information for the fine cutting required around the strips you will want to call it MillingCompSide and use a fine milling tool like the Unimill100.  For the bigger lines you should select the RubboutCompSide and use a bigger milling tool like the 4DoubleEdge20S which is a .079 inch EndMill.  Make sure that each imported file has a phase number from 1 to 8 to the left of the file name in the phase file list, then exit Project by clicking the ‘OK’ button.

Now would be a good time to change the units if you are not happy with the current setting.  Keep in mind that all values in Boardmaster will be displayed in the units you selected.  It is  a good idea to select metric since that is what is used in MDS.  To change the units select ‘Machine’ from the top bar and go to ‘Settings’ and click on the appropriate unit circle.

PLACEMENT



Next you must place your project on the board.  The entire board is displayed on the screen if you go to ‘View’ - ‘Machine’.  Once you have done this select ‘Placement’ from the top bar and click on the ‘Add’ button.  Select your project from the list.  Click on the ‘Accept’ button and then select ‘OK’ to exit the placement window.  Your circuit should now appear on the screen at the zero point of the board.  You should check with the cursor to make sure the dimensions are correct.  This might require zooming in using selections under ‘View’ from the top bar.  If the dimensions are not correct you will have to change the scaling under ‘Project’.

LPKF MACHINE



You are now ready to use the LPKF machine.  Please note that as of the writing of this tutorial, lab policy is to have someone experienced in running the machine supervise its operation if you have not used it before.  It is very expensive and it is easily damaged if misused.

With this in mind, turn the machine on with the switch on the back left side.  The head should go to the home position and the machine should go off line (select light goes out).  The home position corresponds to the zero point on the screen.  Once a board is correctly installed, find a suitable place to make your circuit.  Keep in mind the machine is not configured for near the very outside of the board.  Also make sure the placement location is away from the pins on the ends because they will break the bit.  

It is up to the user to decide where the milling will be done.  To do this, click on the head movement button in Boardmaster (see diagram in Figure 7).  This will allow you to move the LPKF head around the board by pointing and clicking on the screen. Now click at a point where you want the upper left corner of your circuit on the board.  Write these coordinates down.  Keep in mind the on screen board corresponds to the actual board to be milled by the machine.  When you click on a location, the head should move to the corresponding position.  Note: If this doesn’t happen you may have to hit the select button on the front of the LPKF machine. 

Use a light to check and see if this is where you want the machine to cut the upper left corner.  If it isn’t repeat the steps of clicking the head movement button and clicking at the upper left corner point of your where you want your design.  Each time you should write down the coordinates because you will need them later.

When you get the LPKF head where you want it, click on the move instance button and click and drag the upper left corner of your circuit to the correct coordinates you wrote down.  This will probably require that you zoom in using the ‘View’ selections for accuracy.
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MILLING/DRILLING



Now you are ready to start milling.  

Select your first phase to mill.  This should be the MillingCompSide from the list on the tool bar.  Click on the ‘ALL+’ button.  The part of the board to be milled should now be highlighted.  Make sure the Mill/Drill button has mill selected.  

Click on ‘Start’ to begin milling.  The machine head should come to the front left side and a window will come up requesting you to insert a bit.  After inserting the bit, click ‘OK’.  The machine will begin to mill.  You can see the lines being deselected on the screen as they are milled.  Also note that the bit use number is going up.  This bit should be replaced and the counter reset under ‘Tools’ if this number passes the tool life value to the right of it.  This insures that tool wear doesn’t effect accuracy.

When the machine is done milling, repeat the process of selecting the phase, clicking on ‘All+’, making sure the mill/drill button is correct, clicking ‘Start’, and inserting the correct bit.  The final phase is the cutout phase.  Once it is complete you can grab your circuit and check it out.  

Remember to save your Job (using ‘Save As’) before you turn everything off.   





CONGRATULATIONS! You are done with board milling and can proceed to testing it.
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